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Quentris SA – NV   
License Agreement 

This is the legal agreement between you, and Quentris. 

IMPORTANT:   READ THIS AGREEMENT COMPLETELY BEFORE USING THE SOFTWARE. 

BY BREAKING THE SEAL ON ANY CD-ROM PACKAGE OR BY YOUR INITIAL USE OF THE SOFTWARE, YOU AGREE 
TO THE FOLLOWING PROVISIONS. IF YOU DO NOT AGREE WITH THESE PROVISIONS, DO NOT USE THE 
SOFTWARE, IMMEDIATELY RETURN THE UNOPENED PACKAGE (IF ANY) WITH ALL INCLUDED MATERIALS AND 
YOUR RECEIPT TO YOUR DISTRIBUTOR OR RESELLER (IF ANY) OR, IF NOT, TO QUENTRIS SA-NV AT THE 
ADDRESS PROVIDED. 

TERMS AND CONDITIONS 

1. GRANT OF LICENSE - This Quentris agreement (“License”) permits you to use one copy of the Quentris 
software product acquires with this License (“Software”) on any single computer, provided the Software is 
in use on only one computer at any time. If you have multiple Licenses for the Software, then at any time 
you may have as many copies of the Software in use as you have Licenses. The Software is “in use” on a 
computer when it is loaded into the temporary memory (i.e. RAM) or installed into the permanent memory 
(e.g. hard disk or other storage device) of that computer, except that a copy installed on a network server 
for the sole purpose of distribution to other computers is not “in use”. 

2. COPYRIGHT - the Software is owned by Quentris or its suppliers and is protected by the international 
treaty provisions, and all other applicable national laws. Therefore, you must treat the Software like any 
other copyrighted material (e.g. a book or musical recording) except that if the software is not copy 
protected you may either (a) make one copy of the software solely for backup or archival purpose, or (b) 
transfer the software to a single hard disk provided you keep the original solely for backup or archival 
purpose. You may not copy the Product manual or written material accompanying the software. 

3. OTHER RESTRICTIONS - You may not rent or lease the Software, but you may transfer your rights under 
this Quentris License Agreement on a permanent basis provided you transfer all copies of the Software 
and all written materials, and the recipient agrees to the terms of this agreement. Any transfer must 
include the most recent update and all prior versions. You may not reverse engineer, decompile or 
disassemble the Software. 

4. LIMITED WARRANTY - Quentris warrant that (a) the software will perform substantially in accordance with 
the accompanying Product Manuals(s) for a period of 90 days from the date of receipt; and (b) any 
Quentris supplied hardware accompanying the software will be free from defects in materials and 
workmanship under normal use and service for a period of one year from the date of receipt. Any implied 
warranties on the software and the hardware are limited to 90 days and one year respectively. 

5. CUSTOMER REMEDIES - Quentris’ entire liability and your exclusive remedy shall be, at Quentris’ options, 
either (a) return of the price paid or (b) repair or replacement of the software or the hardware that does 
not meet Quentris’ Limited warranty and which is returned to Quentris with a copy of our receipt. This 
Limited Warranty is void if failure of the software or hardware has resulted from accident, abuse, or 
misapplication. Any replacement Software will be warranted for the remainder of the original warranty 
period or 30 days, whichever is longer. 
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6. NO OTHER WARRANTIES - QUENTRIS DISCLAIMS ALL OTHER WARRANTIES EITHER EXPRESS OR 
IMPLIED INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS 
FOR A PARTICULAR PURPOSE WITH THE RESPECT TO THE SOFTWARE THE ACCOMPANYING PRODUCT 
MANUAL AND WRITTEN MATERIAL AND ANY ACCOMPANYING HARDWARE. THIS LIMITED WARRANTY 
GIVES YOU SPECIFIC LEGAL RIGHT. 

7. NO LIABILITY FOR CONSEQUENTIAL DAMAGES - IN NO EVENT SHALL QUENTRIS OR ITS SUPPLIERS BE 
LIABLE FOR ANY OTHER DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR 
LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR OTHER 
PECUNIARY MOSS) ARISING OUT OF THE USE OF OR INABILITY TO USE QUENTRIS PRODUCT, EVEN IF 
QUENTRIS HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN ANY CASE QUENTRIS 
ENTIRE LIABILITY UNDER ANY PROVISION OF THIS AGREEMENT SHALL BE LIMITED TO THE AMOUNT 
ACTUALLY PAID BY YOU FOR THE SOFTWARE. 

AKNOWLEDGMENT 

YOU AKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, UNDERSTAND IT AND AGREE TO BE BOUND BY 
ITS TERMS AND CONDITIONS. YOU FURTHER AGREE THAT IT IS THE COMPLETE AND EXCLUSIVE STATEMENT 
OF THE AGREEMENT BETWEEN YOU AND QUENTRIS WHICH SUPERSEDES ANY PROPOSAL OR PRIOR 
AGREEMENT, ORAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS BETWEEN YOU AND QUENTRIS OR 
QUENTRIS’ AGENT(S) RELATING TO THE LICENSED SOFTWARE.  

 

© Copyright Quentris S.A. - N.V. 2010 
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1 INTRODUCTION TO SMILE 3 

Smile 3  application will allow you to:  

• Operate, answer, transfer, ... calls using the CS1000 features.  

• Memorize, update and manage phone numbers in an online phone book on your own network.  

• Look up telephone numbers in other phone books.  

• Receive and send email information such as holiday info, personal notes, etc ...  

• Work with your own personal settings of the Smile 3 window. 

• Play your own greetings when receiving calls. 

• Have the ability for call recording. 

• Browse through the web in order to find additional info. 

 

This is how this "one screen" tool will appear on your Personal Computer. 

 

Fig 1. The Smile 3 application. 
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2 START AND CLOSE THE SMILE APPLICATION 

2.1 START THE SMILE APPLICATION 

To start the Smile application, click on the    button on your PC. 

Choose Programs (or All Programs) and select the Smile 3 application (Fig.2) 

 

Fig 2. Start Smile program. 

 

An easier way to start the Smile application is to create a Shortcut  on your desktop. Double click 
the icon and your application will start up.  

When the application is loaded, the ‘Profile selection’ window will appear: 

 

Fig 3. User profile screen 

 

Select your user profile using the drop down box and enter the associated Password to start your Smile 
3 console. 

Note:  If your profile is not in the dropdown list, please ask your network administrator or supervisor 
to add it. Otherwise use the ‘default’ user profile. 
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The Smile application will further start up, showing following screen: 

 

Fig 4. Boot up screen 

 

When the splash window has disappeared, you will see that the display area still shows “Logged Out”. 

 

Fig 5. The display area 

 

To actually start using the Smile application, you further have to log in using the <Login> button .  

 

Notice: 

 

 

The Smile will automatically be put in a ‘Not-Ready’ state, 
after you have logged in. Put the Smile in a ‘Ready’ state by 
pressing the  <Not Ready> button .  The red indication will 
turn off! 
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2.2 CLOSE THE SMILE APPLICATION 

  

Fig 6. Closing the Smile application 

Ensure that all calls are being treated and that you are logged out. The calls will now be routed to 
another operator or to the Night number.  

(Check the options with the administrator of your PBX) 

Choose File and than select Exit. 
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3 THE SMILE 3 WINDOW AND ITS COMPONENTS 

 
 
 
 
 
 

 

 
Fig 7. The Smile 3 user interface 
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• Busy Lamp Field à Status of extensions 
• Private picture 
• Monitoring tools for the administrator (Main/Aux ) 

Additional information / Settings: 
• Volume adjustment of Microphone and speakers 
• Profile (Administrator / Supervisor / Default) 
• Number of Smile operators logged in 
• … 
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4 DETAILED DESCRIPTION OF THE DIFFERENT AREAS 

4.1 MAIN MENU BAR 

The Main Menu Bar contains 6 menu items: File, Directory, Profiles, Tools, Configuration and Help 

 

Fig 8.  Main Menu Bar 

4.1.1 The File menu  

 

Fig 9. File submenu 

2 Entries in this menu: 

Reports Allows you to view and print standard predefined reports of your Smile Directory (Will be available in 
Smile version 3.1) 

Exit  To close the application   

4.1.2 The Directory menu 

The directory menu allows you to manage the phonebook. 

 

Fig 10. The Directory menu 

 

You can choose the following commands: 

• Add contact   Add a contact to the phonebook 

• Edit contact  Change the selected contact 

• Delete contact  Delete the selected contact 

• Edit Operator Note Make a remark concerning the selected contact 

• Delete Personal Note Delete the note that the selected contact has sent to the operator by Email 

 

Notice: the shortcuts corresponding to these commands! 
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4.1.3 The Profiles menu 

According to your profile (User/Operator, Supervisor or Administrator), you will get access to more or less 
commands in the Profiles menu. 

  

Fig 11. User Profile Fig 12. Supervisor/Administrator Profile 

 

You can see that the drop down box looks different. A User-profile cannot ‘Add’ nor ‘Delete’ another User-profile; 
these are Supervisor and Administrator privileges.  

The available commands are: 

• Select Select another user profile  

• Edit Edit the current profile 

• Add  Add a new User-profile 

• Delete Delete an existing User-profile 

4.1.4 The Tools menu 

The Tools menu is only accessible to the Supervisor and the Administrator profiles. For the User-profiles, the 
submenus are greyed out. 

 

Fig 13. The Tools menu 

 

These are database management tools (see Technical Guide for more information)  

4.1.5 The Configuration menu 

 

Fig 14. The Configuration menu 

 

This menu is also only available to the Supervisor and/or the Administrator. See the Technical Guide for further 
information (Chapter 2.3.1 ‘Profiles’) 
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4.1.6 The Help menu 

Here you’ll find information about the Smile 3 console: user guide, technical guide and the current application 
information. 

 

Fig 15. The Help menu 

 

The “About Smile” submenu item gives you following information: 

 

Fig 16. About Smile: identity of the Smile 

 

• Version: The software version of your Smile 3 console 

• License Number: Unique number for your Smile application 

• Distributor Name: Name of the company who has installed the software 

• Customer Name: Name of the end-user’s company 

• HardwareID: Hardware component associated to your license (Dongle, HDD or NIC) 

• Active Users: Number of Licenses actually in use with the corresponding computer name 
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4.2 STATUS BAR 

The status bar at the bottom of the main screen will give you some information about the Smile 3 
console status. 

 

Fig 17. The status Bar 

The status bar provides: 

• Microphone and speakers settings 

• Name of the current user’s profile (User, Default, Supervisor, Administrator) 

• Number of consoles logged in the operator queue 

• Date  

• Time 

4.3 BROWSE WINDOW AREA 

The Browse Window Area is mainly composed of three tabs and a search bar as shown below: 

1. Directory: displays the Smile 3 phonebook 

2. LDAP: displays an external LDAP compliant directory 

3. Web: allows to browse five predefined web sites (e.g. Intranet phonebook) 

4. Search bar 

1 2 3 

 

 

4 Search bar  Fig 18. The Browse Window Area (phone book). 
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4.3.1 The Directory Browse Window 

The Directory Browse Window allows you to quickly retrieve contact information from the phonebook (e.g. phone 
number, mobile, etc). Moreover it allows you to use it to make or extend (transfer) calls. 

It is important to keep this directory up-to-date for the caller’s recognition. 

Smile 3 can handle caller's recognition for internal as well as external telephone numbers. An internal or external 
caller will be identified if already listed in the directory. The yellow bar will automatically highlight the caller’s 
entry in the phonebook.  

 

Looking up information in the Directory window: 

Clicking on the Left/Right arrows of the PC keyboard will highlight the cells of a column with a pink colour. 

 

The pink column indicates the current search column (at this moment the column "Lastname”), and the yellow 
row (at this moment "Volta Alessandro") indicates the current record. (See Fig 18.) 

 

In order to perform a search, use the Left/Right arrow keys to select a column, and then type in the search bar 
field the first characters of the known information (name, telephone number...), see Fig 18. The Smile will 
retrieve all records from its database matching the search criteria typed in the search bar. 

If necessary, you can also use the Up/Down arrow keys and the PgUp/PgDn keys to select a record.  

It is possible to make a search on more than one column (multi criteria search), for instance if there are persons 
with the same last name. Fill in the known first letters of the last name at the bottom of the ‘LastName’ column, 
i.e. in the corresponding search bar field. It will give you all the persons with the same last name. 

Now select the ‘FirstName’ column using the Left/Right arrow keys, and then enter the known letters of the first 
name in the field of the search bar at the bottom of this column. The system will filter out all contacts meeting 
the search criteria. 

Eventually the yellow line will point automatically at the right person. 

 

Remark: When you have to look up a telephone number, you have to move the pink column towards the phone 
column and than use the alphanumeric keys instead of the numerical keypad. 

 

Extra information fields concerning the selected records are: 

 

OPERATOR NOTE 

 

Fig 19. The Operator Note 
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PERSONAL NOTE 

  
Fig 20. The Personal Note 

 

The Smile can receive e-mails if the ‘Mail Service’ facility is configured. They will appear in the Personal Note of a 
selected record.  

THE BROWSE WINDOW AREA TOOLBAR  

 

Fig 21: Browse window toolbar 

 

 Add a contact (F2) 

 Edit or View the current contact (F3)  

 Delete the current contact (F4) 

 Edit Operator Notes (F7) 

 Delete the Personal Note (Alt F7) 

 

4.3.2 The LDAP Directory  

The LDAP Directory allows you to retrieve records from an external LDAP compliant database. Click on the 
<Search> button in order to retrieve this information. 

Multi criteria search is also applicable here via the search bar. 

 
Fig 22. LDAP Directory 
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4.3.3 The Web window 

The Web window shows you five predefined web pages, to get access to extra information. 

 

 

Fig 23. The Web window 

 

To configure these web pages, go to the Main Menu bar and select ‘Profiles\Edit’ the profile and choose for the 
Web option. 

 

 

Fig 24. Configure five Web pages 
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4.4 CURRENT CALL AREA 

The Current Call Area is used to manage the phone calls. 

 

Fig 25. Current Call Area 

 

On the left of the current call area you can see a gauge indicating the number of calls waiting in the 
queue. If there are more calls waiting than a pre-configured number, the blue ball will change colour to 
red.  

The time at the bottom of the gauge shows the longest waiting time in the queue. 

  

Fig 26. Two calls waiting Fig 27. Three calls waiting  
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If you look at the display (Fig 25.), the Smile is still logged out.  

To login, push the login button   (See ”Start up the Smile application”). 

The console is now turned in ‘Not Ready’ state . So, this means you are logged in the operator queue 
but not yet ready to accept incoming calls. 

To accept incoming calls, click on the ‘Not Ready’ button. The red light in the button will turn out . 

 

The Function buttons for call handling are: 

Call or transfer the current call to the first alternative number (Forward 1) of the selected 
person. See contact configuration. 

Call or transfer the current call to the second alternative number (Forward 2) of the 
selected person. See contact configuration. 

Call or transfer the current call to the mobile number of the selected person. See contact 
configuration. 

Call or transfer the current call to the ESN number of the selected person. See contact 
configuration. 

Transfer the current call to the voice mailbox of the selected person. 
 
 
 

Send a phone call notification by e-mail to the first e-mail of the selected person.  
(See pg. 27) 

 
Send a phone call notification by e-mail to the second e-mail of the selected person. 

   
 

Open the calendar of the selected person.  
(See pg. 28) 

 
 

Mute the microphone. 

Put the current call On Hold. 

Park the current call on the System Park  DN. 

Call Intrusion, break into an established conversation. 

Make a conference. 

Dial pad activation. DTMF sending. 
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Play your operator’s greeting 

Call recording 

 
 

On hook indicator 

Off hoof indicator 

 

 
Exclude the Source. The caller will hear the music on hold and the operator will be 
reconnected to the called party.  

Exclude Destination. The called party will hear the music and the operator will be 
reconnected to the caller. 

Release the Source. The caller will be disconnected and the operator will be reconnected 
to the called party if any. 

Release the Destination. The called party will be disconnected and the operator will be 
reconnected to the caller if any.  

 
 
 

Login. Logs the operator in the queue. 

Not Ready (inactive). Allows the operator to put the console in ‘Not Ready’ state. 

Not Ready (active). Allows the operator to put the console in ‘Ready’ state. 

Make Set Busy (inactive). Allows the operator to put the console in ‘Make Set Busy’ 

Make Set Busy (active). Allows the operator to de-activate the ‘Make Set Busy ‘ state. 
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5 USING THE SMILE APPLICATION 

5.1 CONSOLE STATUS 

When starting up, the Smile 3 console comes in the  "Logged out" 
status as indicated on the display window.  

 

Fig 28. Display -Logout 

Clicking on the <Login> button  will log the console in the operator 
queue. The display provides the queue information and the message ‘Not 
Ready’ will appear after a while. 

 
Fig 29. Display - NotReady 

 

To turn the console in ‘Ready’ state, click on the <Not Ready> button . 
You are now ready to accept incoming calls.  

 
Fig 30. Display - Ready 

 

When you are not able to accept incoming calls (i.e. away from desk for a moment), the <Not ready>  

button  can be reactivated.  

The red light shows the ‘Not ready’ state is active ( ). In this state, the incoming calls remain in the 
queue and are waiting to be answered. The call waiting gauge (see pg. 19) shows the number of calls 
waiting. 

Removing the ‘Not ready’ status by clicking again on the <Not ready> button enables the console to 
receive the calls from the queue.  

Remark:  The ‘Priv’ line is not affected by the "Not ready" status. You will still receive calls on your ‘Priv’ 
Line. 

To remove the console from the queue (i.e. at night), the operator can click on the <Make Set Busy> 

button .  

When active, it shows a red light inside the button  and the display shows: "Set busy activated". This 
action logs out the console and prevents receiving calls even on the private line. Though, it remains 
possible to make outgoing calls on the ‘Priv’ line. 

To log in, click again on the <Login> button . 
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5.2 ANSWER AN INCOMING CALL  

 

Fig 31. Answer a call 

 

Answer a call by simply clicking on the yellow phone, or by  
pressing the <Enter> key. 

 

1. To transfer the call 

Select the called party in the phonebook and press the 
<Enter> key or dial immediately the known phone 
number using the numeric keypad. The dial box will open 
automatically. 

Press the <Enter> key to initiate the call. 

2. Press the <+> key on the numeric keypad to complete 
the transfer. 

Blind and screened transfers are both possible.  

To cancel a transfer (busy tone, no answer, voice mail box) click on the “Release Destination button” 

.  You are then reconnected to the caller. 

 
Fig 32. Numeric keypad 
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5.3 MAKE A CALL 

The number to call is listed in the directory:  

• Perform a search 

• Press <Enter> to take a line 

• Press <Enter> again to call the currently selected number  

 

A number that is not present in your directory:  

• Press <Enter> to take a line 

• Use the numeric keypad to compose the number 

• Press <Enter> again to call that number 

 Fig 33. Dial Box 

Notice:  For outgoing calls, the ‘Priv’ line is always used. The ‘ACD’ line is only for incoming calls. 

5.4 PUT A CALL ON HOLD 

Sometimes a person would like to wait until the called party becomes available. 

In this case you can put the caller On Hold by clicking the <OnHold> button  or use the shortcut < / 
> on  the numeric keypad. 

As an option a ‘Label On Hold’ window will appear. There you can enter the caller’s name, so you can 
remember his name when you announce him again to the called party. 

 

Fig 34. Label On Hold 

The caller is placed on hold and you are free to process other calls. 
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Fig 35.  A call on hold 

Remark: the Smile remembers for whom the call was for (Destination: Pierre Curie). The wait time of the 
on hold party is indicated in the ‘Time’ column and will change colour after a predefined time to draw 
your attention. (See: Configuration/Console Preferences/General/Calls Waiting) 

5.5 RETRIEVING A CALL THAT WAS PUT ON HOLD 

 

Fig 36. The On Hold area 

 

To retrieve a call that was previously put on hold, you can click on the green icon corresponding to the 
call on hold, or press <Alt+1 to Alt+5> according to the line where the on hold party stays.  

The ‘Call On Hold’ feature allows you to put up to five calls on hold. 
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5.6 SETTING UP A CONFERENCE CALL 

A conference call can be set up for as many as six persons, including yourself, at the request of either an 
internal person (extension) or an outside caller.  

At least one of the conferees must be an internal line.  

How do you set up a conference call? 

1. Click on the <On/Off Hook> button or press the <Enter> key to take a line. 

2. Dial the number of the first conferee. 

3. When connected, press the <Conference> button  and dial the number of the second conferee. 

4. When connected, press again the <Conference> button . 

5. The conference call is started when the  icon appears. 

6. You can invite other persons as well, simply by repeating point 3 and 4.  

7. If you want to leave the conference, then press the <Release Source> button or F11. 
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6 MANAGING THE SMILE 3 DATABASE 

6.1 ADD A CONTACT 

• Pressing the F2 key or the <Insert> key 

• Or via the item 'Add Contact' in the Directory menu,  

• Or by using the <Add Contact> button  in the browse window 

 

The following screen is presented to you: 

 

Fig 37. Add a Contact 

You‘re able to enter: 

• The last name (mandatory)  

• The first name  

• The telephone number (mandatory)  

• Mark the telephone number whether this is internal or external. 

• The Mobile number  

• Two forwarding numbers  

• The private network number 

• The account code 

• Two e-mail addresses (e.g. a professional and a private one)  

• The exchange profile 
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6.2 MODIFY A CONTACT 

• Pressing the F3 key  

• Or via ‘Edit Contact’ in the Directory menu  

• Or by using the <Modify Contact> button  in the browse window toolbar. 

 

All the information of the record will be presented. 

 

Fig 38. Edit a Contact 

6.3 DELETE A CONTACT 

• By pressing F4 key or the <Delete> key 

• Or by using the <Delete Contact> button  in the browse window toolbar. 

• Or via the item 'Delete record' in the Directory menu  
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7 HANDY FEATURES 

7.1 DIRECT CONNECTION TO THE VOICE MAIL 

Pressing the <Express Messaging> button  or <Ctrl-5>, enables you to transfer a call directly to the 
‘Voice Mailbox’ of the selected person. If you want, you can change this number and enter another one. 

The Smile application will automatically call the ‘Express Messaging’ number, wait for the voice mail 
system to answer the call and compose the mailbox number.  

Press the  < + > key to extend the call. The source (caller) will be connected to the voice mailbox and a 
message can now be left in the voice mailbox of the called person.  

7.2 NOTIFYING A PERSON VIA E-MAIL 

If you want to notify a person, that he has missed a call, then you can send him an e-mail by pressing 

the <Send Email1> button .  

The Smile application will fill in automatically the subject as a “Phone Call notification”.  

When you configure a contact, you’re able to define a second e-mail address, for example a Home 

address. If you want to notify the person on his second e-mail address, you press the  button.  

Pressing one of these buttons will show you following screen: 

 

Fig 39. Sending e-mail 
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7.3 CONSULTING A PERSON’S CALENDAR 

With the Smile application you are able to consult a person’s calendar to see if he’s available. That 

person has to give you the authorization to look into his calendar or to change it.  

 

 

Fig 40. Calendar Feature 

7.4 EXCLUDE SOURCE OR DESTINATION 

These features are necessary to toggle between the caller (‘ACD’ or ‘Priv’ lines) and the called party 
(‘Dest’ line) without extending the call. You can either talk to the caller or to the called person. 

Exclude Source 

Exclude Destination 
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7.5 BUSY LAMP 

The Busy Lamp field is a panel that allows the operator to monitor the status of some predefined 
internal extensions. 

The attendant can tell the caller whether the person is busy prior to transfer the call. This service will 
make a better ‘First Impression’. 

 

 

Fig 41. Busy Lamp Screen 

7.6 SYSTEM PARK 

When pushing on the <System Park> button  or <Ctrl-P>, an established call (‘Priv’ or ‘ACD’ line) can 
be placed in a Parked status. When you park a call, you receive a ParkDN displayed in the ‘Call Parked’ 
window. This window pops up just after depressing the Park key. 

 

Fig 42. Call Park Box 

 

To retrieve a parked call, the operator or any other telephone user must dial the Park DN (i.e. 19403). 
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7.7 SEND DTMF 

When reaching interactive servers such as IVRs or Voice Menu systems, it is necessary to send DTMF 
tones to input further information.  

You can start the end-to-end sending by pressing the  <Send DTMF>  button  or use the shortcut  
< - >. 

 

When active, the display looks as follows:  

 

The Display area is in bold. 

Fig 43. Send DTMF 

To deactivate it just click again on the <Send DTMF> button. 

7.8 CALL RECORDING 

This feature allows the operator to record the current conversation. The operator starts and stops the 

recording by pressing the <Call Recording>  button (Shortcut is Ctrl-R). When the recording is 

started, the icon changes to: .  

The path, where the recorded files are located, is specified in the Configuration/Console Preferences/Call 
Recording window. Each created record file is named with the current date and time allowing an easy 
lookup. 

 

Fig 44. Call Recording configuration. 
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7.9 OPERATOR GREETING 

This Smile 3 feature allows the operator to play a greeting message to the incoming caller on the ‘ACD’ 
line. The greeting is pre-recorded on a .wav file (see General tab of the Profile-Edit). 

Start and Stop using the <Operator Greeting> button  or the shortcut <Ctrl-G>. 

When the greeting is switched on, the icon changes to:  

7.10 FORCE MAKE CALL 

When an operator receives an incoming call and it’s just ringing, it is still possible to make an outgoing 
call prior to accept the incoming call.  

Typing  <Alt-6> will pop up a dial box and allow the operator to make an outgoing call first. In the 
meantime, the incoming call will be placed in the waiting queue. 

7.11 FORCED CAMP-ON 

The operator can camp an external or internal call on to an internal station that is busy.  
When the operator completes the transfer, the external or internal calling party will Camp-On to the 
desired party and will receive ring-back tone or music. 

Forced Camp-On can be done with either no call on hold or an external or internal call on hold.  

It can be done automatically or manually. Whether it is automatic or manual depends on how the PABX 
is configured (see Technical Guide)  

• Manual operation: once a busy telephone has been reached, press the <Call Intrusion> button 

. If successful, you will receive a Camp-on tone. If the Forced Camp-On 
didn’t work, you will receive a fast busy-tone. You can try again. 

• Automatic operation: once a busy telephone has been reached, Forced Camp-On is attempted 
automatically on the busy party. 

Remark: 

 

During the manual operation, if you press a second time on the <Call 
Intrusion> button, you will break into the call. This is called ‘Call 
Intrusion’. 
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8 SUPERVISOR / ADMINISTRATOR INFORMATION 

8.1 EDIT THE PROFILE 

As Supervisor or Administrator, you may want to configure a profile, please open then the ‘Profiles’ 
window from the menu bar: 

 

Fig 45.  Edit the Profile 

 

The fields on the ‘General’ submenu are: 

• Image: The location where the Smile can find the personal image. 

• Greeting: The location where the greeting is installed. 

• Language: The language of your application 

• Skin: The color of your background 

• Automatic On Top: Smile will automatically become the active program when there is an 
incoming call. 

• Automatic Maximize: Whenever there is an incoming call, Automatic Maximise will maximise the 
Smile application 

• Label On Hold: Whenever a call is put on hold an extra window is presented. This window will 
allow you to fill in some extra information (a label) with a reference to this 
call. 
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8.2 BROWSE WINDOW CONFIGURATION 

By selecting the ‘Directory’ item from the ‘Profile’ menu, you can decide which column titles you want to 
see in the Browse Window Area. You can add or remove fields, and determine their position by clicking 
the <Move Up/Down> buttons. If you are satisfied with the results, click on <Save> to save these 
settings.  

 

Fig 46. Browse Window configuration 

 

‘Edit Notes’ and ‘Edit Database’ options can be selected whether the Profile can, or cannot, edit the 
Operator Notes or the Database. When ‘Edit Database’ is not selected, the profile cannot add/edit or 
remove a contact. 
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8.3 LDAP DIRECTORY 

In the ‘LDAP’ profile item, you can customise the field names on the LDAP Directory screen. These fields 
are the titles of each column in your LDAP Directory data base presentation. 

 

Fig 47. LDAP configuration screen 
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8.4 WEB BROWSE WINDOW 

This part of the Profiles menu/Web allows you to modify the web tab window in the Directory Browse 
Window.  

As you can see in following figure, simply by filling in the form you can predefine five access pages. 

 

Fig 48. Web configuration screen 
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8.5 AUDIO SETTINGS 

This permits the operator to adjust some sound parameters such as the microphone level, the speakers 
or receive level for the headphones and the ringer loudness.  

The available audio devices can be selected from the pull-down boxes.  

With the bottom checkboxes, the operator can enable or disable the automatic gain control and the echo 
cancellation. 

 

Fig  49. Audio Settings 
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9 SOME CALL STATES AND THEIR VIEW 

 
 

Incoming call ringing 
 
 
Fig 50. Incoming call ringing 
 
 

Incoming call answered 
 
 
Fig 51.Incoming call answered 
 
 

Incoming Private call 
 
 
Fig 52. Incoming Private call 
 
 

Incoming Private call answered 
 
 
Fig 53. Incoming Private call answered 
 
 

Incoming call, on hold, and operator is on 
conversation with the Destination (Pierre Curie) 

 
 
 
  
 
 
Fig 54. The operator and its two parties: Caller and Called party.  

 
 

The call area in full operation:  

 

Fig 55. Current Call area 
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10 NETWORKING 

 

When you have two or more Smile applications running on your network, you can use the Networking function to 
centralize all the contacts in one master database that will be used by all the applications. Every time an operator 
makes a modification in the database (e.g. updating the information of a memo field), it will be automatically 
visible for all the operators working in the same Smile network. 

The simplest way to achieve this customer’s requirements is to select a Smile 3 Console to become the ‘Master’, 
the other ones becoming ‘Slaves’.  

Pay attention: 

 

 

 

In order to remain up and running during a network issue or an unavailability of the Master Smile 3 console, each 
Smile 3 Consoles will keep, on closing, a local copy of the system database and profiles. 

For the different networking architecture possibilities please see the Technical Guide. 

 

The operator desktop selected as Master Smile 3 Console should not be 
switched off. 
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11 OPERATOR SHORTCUT KEYS 

 

Alt 1 to Alt  5  Retrieve a call on hold  

Alt 6 Open a dial box 

Ctrl 1  Alternate destination 1  

Ctrl 2  Alternate destination 2  

Ctrl 3  Mobile  

Ctrl 4  ESN 

Ctrl 5  Send the call automatically to the Voice mail  

Ctrl 6  Open e-mail 1  

Ctrl 7  Open e-mail 2  

Ctrl 8  Open the calendar  

Ctrl P   Park  

Ctrl I Intrusion 

Ctrl M Mute/Unmute 

Ctrl N Not ready 

Ctrl L  Login  

Ctrl O Make Set Busy 

Ctrl G  Operators greeting  

Ctrl F  Conference  

Ctrl R Call recording 

F1  On line help  

F2  Ins  Insert a record  

F3  Modify a record  

F4  Del  Delete a record  

F5  LDAP search  

F7  Edit Operator Note  

Alt  F7 Delete personal note 

F9  Exclude Source  

F10  Exclude Destination  

F11  Release Source  

F12  Release Destination  

 -  Dial pad control  

N. Keypad ENTER  Off hook   

N. Keypad +  Call release  

N. Keypad /  On hold  

N. Keypad *  Send DTMF star ( *) 

N. Keypad . (dot)  Send DTMF hash (#), number sign or square sign  

Esc  Go to the top left of the directory  

PgUp  Go one page up in the directory  

PgDown  Go one page down in the directory  

Shift F1 to Shift F5  Busy Line Field (BLF) page selection (Available on Rls 3.1) 
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Did you know that Smile software for Meridian 1 and CSE 1000 attendant 
console solutions has been a bestseller in the market for several years? 

Thousands of Smile systems are already installed across Europe, Middle 
East and Africa. 

 

 

 

 

 

 

 

 

For more information about Smile please contact 

 

The Smile Team 

 

E-mail: smile@quentris-gdfsuez.be 

 

Or consult our website at http://www.SmileConsole.com 

mailto:smile@quentris-gdfsuez.be
http://www.SmileConsole.com

